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Organize data for mailing labels in an Excel spreadsheet by including fields such as First Name, Last Name, Street Address, City, State, and Postal Code. After listing the data, you'll see a screenshot similar to this.###ARTICLEClick OK in the Data Contains Column Headers dialog box. Youll notice in all labels except the first one, indicating
successful linkage to the Excel worksheet. Read More: How to Create Labels in Word from Excel Step 4 Map Fields for Excel Data Conversion Add mail merge fields to the labels by selecting the first label and going to Mailings and selecting Address Block. The Insert Address Block dialog will appear, showing a Preview of individual labels. If needed,
adjust the arrangement by clicking on Match Fields. Review and ensure the column data from your Excel file matches the fields in the Required for Address Block section. Once done, click OK. After matching the fields, youll see a final preview of labels. Click OK. Youll now observe displayed in the first label. Add the AddressBlock to each label by
going to Mailings and selecting Update Labels. Read More: How to Create Labels Without Word in Excel Step 5 Complete the Merge To finalize the conversion of Excel data into Word labels, go to the Mailings tab, click Finish & Merge, and select Edit Individual Documents. In the Merge to New Document dialog, select All and click OK. Youll see all
Excel data merged below with the labels in Word. Read More: How to Merge Excel File to Mailing Labels Print Labels from Word To print the labels, simply press Ctrl + P or navigate to the File tab in Word and select Print. Choose the printer and print the labels. Things to Remember Utilize the Step-by-Step Mail Merge Wizard for converting Excel
data to Word labels. Avoid including blank columns/rows in the Excel list containing mailing data. Download Practice Workbook You can download the practice workbook from here: Excel to Word Labels.xlsx Save.Then, configure label dimensions in Word by launching Microsoft Word and selecting Mailings > Start Mail Merge > Labels from the top
toolbar. Select a label vendor and type, then choose OK. If you want to create a custom label, select New Label and specify your dimensions on the following window.Next, import data from your Excel spreadsheet into your Word document while it's still open. Select Mailings > Select Recipients > Use an Existing List in the top toolbar, navigate to the
folder containing the Excel spreadsheet, and double-click it. In the Word document, select the Mailings tab, ensure you're on the labels document, and then from the Write & Insert Fields section, select Address Block.In the Insert Address Block window, select Match Fields and make sure each field in the Required for Address Block matches with the
appropriate field in your spreadsheet. Select OK to close the window and preview the label. Ensure this represents the actual labels you want to create. Then, select OK at the bottom of the window.Finally, in the Mailings tab of Word, select Update Labels to display the actual data for each label. Then, choose Finish & Merge > Edit to complete the
process. To create your labels document, documents from the menu appear. In the window that opens, choose All and select OK. Your Word document should now display all your labels with their individual data. You can save this labels document or generate a PDF out of it. Alternatively, you dont need to use a third-party tool to save your Words label
document as PDF. Select the File tab at the top of the Word window and choose Save As. Browse on the right pane and select a folder to save your PDF in. Enter a name for your PDF in the File name field, then select Save. To print your labels directly from Word, make sure your printer is connected to your computer. Select the File tab at the top of
the Word window, select Print in the left sidebar, choose a printer from the Printer menu on the right pane, and then select Print at the top. You can also organize data for your mailing labels in an Excel spreadsheet. For instance, include fields like First Name, Last Name, Street Address, City, State, and Postal Code.Once you've downloaded the
practice workbook from here, you can begin using mail merge in Microsoft Word to create your mailing labels from an Excel list.Step One: Prepare your Mailing ListIf you haven't already created a mailing list in Excel, you'll need to set up your data first. Create a column header for each piece of information you want to include on your label, such as
First Name, Last Name, and Address. Make sure the headers are placed in the top row of each column.Next, fill in the data for your mailing list. You can use this opportunity to customize your labels further, such as adding images or logos. Don't forget to save your workbook before moving on to Microsoft Word.# ##ARTICLETo merge your list from
Excel into Word labels, follow these steps: Once you've listed your data in Excel, navigate to the Mailings tab in Word. From there, select Labels and set the Label vendors and Product number according to your requirements. You'll now see the label format outlined in Word. Next, link your Excel data with Word by choosing Use an Existing List, then
select the appropriate sheet and check First row of data contains column headers. After that, map fields for Excel data conversion by selecting the first label and going to Mailings, then Address Block. Ensure the column data from your Excel file matches the fields in the Required for Address Block section. Finally, complete the merge by clicking
Finish & Merge, then select Edit Individual Documents.To create mailing labels from Excel data in Word, one must properly structure their spreadsheet beforehand to facilitate an efficient mail merge process. This includes creating a clear layout with well-defined column headers and addressing relevant information such as salutations and zip
codes.Before starting a mail merge, invest time in setting up your Excel sheet by creating separate rows for each recipient and assigning descriptive names to the columns. For instance, use full words like "Address" instead of abbreviations to avoid confusion during the merge process.###ARTICLETip: If the Use the current document option is
inactive, then select Change document layout, click the Label options link, and then specify the label information. Configure label options. Before proceeding to the next step, Word will prompt you to select Label Options such as: Printer information - specify the printer type. Label information - define the supplier of your label sheets. Product number -
pick the product number indicated on a package of your label sheets. If you are going to print Avery labels, your settings may look something like this: Tip. For more information about the selected label package, click the Details button in the lower left corner. When done, click the OK button. Now, it's time to link the Word mail merge document to
your Excel address list. On the Mail Merge pane, choose the Use an existing list option under Select recipients, click Browse and navigate to the Excel worksheet that you've prepared. The Select Table dialog box will pop up. If you have given a name to your mailing list, select it and click OK. Otherwise, select the entire sheet - you will be able to
remove, sort or filter recipients later. The Mail Merge Recipients window will open with all the recipients from your Excel mailing list selected by default. Here are some of the actions you can perform to refine your address list: To exclude a particular contact(s), clear a check box next to their name. To sort the recipients by a certain column, click the
column's heading, and then choose to sort either ascending or descending. To filter the recipient list, click the arrow next to the column heading and pick the desired option, e.g. blanks or non-blanks. For advanced sorting or filtering, click the arrow next to the column name, and then select (Advanced) from the drop-down list. A few more options are
available in the Refine recipient list section near the bottom. When the recipient list is all set, click Next: Arrange your labels on the pane. Now, you need to determine what information to include in your mailing labels and decide on their layout. For this, you add placeholders to the Word document, which are called mail merge fields. When the merge
is finished, the placeholders will be replaced with the data from your Excel's address list. To arrange your address labels, follow these steps: In your Word document, click where you want to insert a field, and then click the corresponding link on the pane. For mailing labels, you'd normally need only the Address block. In the Insert Address Block
dialog box, select the desired options, check the result under the Preview section and click OK. When you are finished with the Address Block, click OK. The AddressBlock merge field will appear in your Word document. Note that it's just a placeholder. When the labels are printed out, it will be replaced with the actual information from your Excel
source file. When you are ready for the next step, click Next: Preview your labels on the pane. Well, we are very close to the finish line :) To see how your labels will look like when printed, click the left or right arrow on the Mail Merge pane (or the arrows on the Mailings tab, in the Preview Results group). Tips: To change label formatting such as font
type, font size, font color, switch to the Home tab and design the currently previewed label to your liking. The edits will be automatically applied to all other labels. If they are not, click the Update all labels button on the Mailings tab, in the Write & Insert Fields group. To preview a certain label, click Find a recipient link and type your search criteria
in the Find Entry box. To make changes to the address list, click the Edit recipient list link and refine your mailing list. When you are satisfied with the appearance of your address labels, click Next: Complete the merge. You are almost done.Ready to print mailing labels from your Excel spreadsheet by following these simple steps. Simply click Print
on the Mailings pane (or Finish & Merge > Print documents on the Mailings tab). And then, indicate whether to print all of your mailing labels, the current record or specified ones. If you want to save the mail merge document connected to the Excel sheet, click Save the Word mail merge document and press Ctrl + S shortcut.If you make any changes
to the Excel mailing list, the labels in Word will be updated automatically. The next time you open the document, Word will ask you whether you want to pull the information from the Excel sheet. Click Yes to mail merge labels from Excel to Word.To save merged labels as text, click Edit individual labels on the Mailings pane. Specify which labels you
want to edit and then make any edits there before saving the file as a usual Word document.If none of the predefined options in the Address Block is suitable for your needs, create a custom layout of your address labels by placing the cursor where you want to add a merge field on the Mailings pane. Select the desired field and click Insert Merge
Field.Tips: To copy the layout of the first label to all other labels, update all labels on the Mailings pane or use the same button on the Mailings tab. You can also add some text or graphics to be printed on each label.For this, select the needed field, press Shift + F9 to display the field coding, and then add a picture switch as explained in How to format
mail merge fields. Make sure that address elements match the selected address pattern by verifying whether your Excel source file contains all the required data.Hurray! You finally did it :) Thanks a lot to everyone who has read our Mail Merge Labels tutorial to the end!Now navigate to the Word label format options, but note that if you can't see it,
go to Table Design, pick Borders, and click View Gridlines in the menu. Step three - linking Excel data to Word labels involves going to the Mailings tab, expanding Select Recipients, and choosing Use an Existing List from the dropdown. Locate your Excel file's path, open it, and select the worksheet that suits your needs. Ensure 'First row of data
contains column headers' is checked before clicking OK. You'll notice in all labels except the first one, confirming a successful connection to the Excel sheet. For more information on linking Excel data with Word labels, read How to Create Labels in Word from Excel List. Step four - mapping fields for Excel data conversion requires selecting the first
label and going to Mailings > Address Block. The Insert Address Block dialog will appear, displaying a preview of individual labels. If necessary, adjust the arrangement by clicking Match Fields. Review the column data from your Excel file against the Required for Address Block section's fields. Once done, click OK, then you'll see a final preview of
labels. After matching fields, observe displayed in the first label and add it to each label by going to Mailings > Update Labels. Step five - completing the merge involves going to the Mailings tab, clicking Finish & Merge, and selecting Edit Individual Documents. In the Merge to New Document dialog, select All and click OK. You'll see all Excel data
merged below with the labels in Word. For more information on merging Excel files to mailing labels, read How to Create Labels Without Word in Excel or How to Merge Excel File to Mailing Labels. To print the labels, simply press Ctrl + P or navigate to the File tab and select Print, then choose your printer. Things to Remember - utilize the Step-by-
Step Mail Merge Wizard for converting Excel data to Word labels and avoid including blank columns/rows in the Excel list containing mailing data.To make use of Microsoft Excel for organizing a mailing list, you can mail merge this list using Word to generate and print mailing labels. It's recommended to utilize Excel as it has better organizing
capabilities than a Word table when it comes to maintaining data. To begin with creating the list in Excel, you must create column headers by placing them in the first row of each column. Next, insert data in the list according to the header in each column.In order to make use of mail merge, open a new Excel worksheet and enter the required headers
such as Name, Surname, Street Address, City, State, PIN Code, etc. You can change or add headers according to your mailing list needs. Save the file with an appropriate name and format under the Other Locations tab in File Manager.After preparing your Excel data, open a blank document in Word and select the Mailings tab from the top menu bar.
Click on Labels in the Start Mail Merge section, which will open the Label Options dialog box. Here you can choose the label vendor, product number, paper tray, etc. Once done, click OK to create the labels page.To complete the merge process, go to the Mailings tab and select Edit Individual Documents under the Finish & Merge option. In the
Merge to New Document dialog, choose All and click OK. This will display all Excel data merged below with the labels in Word. To print the labels, simply press Ctrl + P or navigate to the File tab and select Print.To remember, use the Step-by-Step Mail Merge Wizard for converting Excel data to Word labels. Avoid including blank columns/rows in the
Excel list containing mailing data. You can download a practice workbook from this link: Excel to Word Labels.xlsxTo access the Mailing List feature, navigate to the Mailings tab in the top menu bar and select Write & Insert Fields. Click on the Address Block icon to open the Insert Address Block dialog box. Match the headers in your mailing list with
the fields on the left and click OK to continue.Next, update the labels page by selecting the Mailings tab and clicking on Update Labels. Then, select the Finish & Merge icon and choose Edit Individual Documents from the drop-down menu. Select All records under Merge Records and click OK to close the dialog box.Now, access the File menu and
select Print. Choose Microsoft Print to PDF as your printer and select Print All Pages and One Sided settings. Click the Print button to open the File Manager. Save the PDF file for later printing.If you prefer not to use Word's mail merge feature, you can also print labels from Excel by adjusting border sizes. However, if you want a more
straightforward method, using the mail merge tool in Word is recommended.To start, prepare your Excel data by organizing each column into specific fields with column headers. Make sure to include commonly used fields such as First Name, Last Name, City, and Zip Code.Next, open MS Word and create a new document as your template for the
labels. Navigate to the Mailings tab and click on Start Mail Merge to begin the process. Select Labels from the drop-down list and follow the prompts to merge your data into the template.To utilize MS Word's mail merge feature for printing labels from Excel, select "Labels" from the list, which prompts a "Labels option" dialog box where you can
choose label type and size. If desired, create custom sizes by clicking "New Label" to manually input dimensions. After selecting preferences, click "OK." Next, navigate to the "Mailings" tab and click "Select Recipients," then choose "Use an existing list" from your computer's spreadsheet containing label data. Select the relevant sheet and range to
confirm.Continue in the "Mailings" tab by clicking "Insert Merge Field" to manually select fields from your spreadsheet. Alternatively, use the "Address Block" button with "Match Fields" checked for accuracy. After inserting merge fields, click "OK." The result is updated after clicking "Update labels."To customize label design, access formatting tools
like changing font style, adding images or logos, and adjusting font size to enhance appearance. Finally, preview results by clicking "Preview Results" in the "Mailings" tab before proceeding with the final step.
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